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Abstrak 

Tujuan program pengabdian (PPM) ini adalah meningkatkan penguasaan uji statistik 

yang bersifat terapan dalam bidang penelitian pendidikan bagi guru IPA di Sleman, Yogyakarta 

dengan menggunakan buku ajar statistik terapan. Kegiatan PPM ini diperuntuk bagi guru-guru 

IPA di Sleman, Yogyakarta. Pelaksanaan kegiatan ini akan disatukan dengan agenda kegiatan 

MGMP guru IPA di Sleman, Yogyakarta yang dilakukan secara rutin. Pelatihan dilakukan di 

Laboratorium Komputer Jurusan Pendidikan IPA FMIPA UNY. Bentuk kegiatan PPM yang 

akan dilaksanakan dalam kegiatan PPM ini meliputi: tutorial, praktik, tugas terstruktur, dan 

konsultasi tugas. Pelatihan ini diikuti oleh 10 peserta dari target 20 peserta dari guru-guru IPA SMP 

di Sleman, Yogyakarta. Hasil kegiatan pelatihan ini yaitu guru memiliki pemahaman dasar dalam 

uji statistik untuk penelitian pendidikan dan mampu memiliki kemampuan menggunakan 

aplikasi SPSS dalam uji statistik. 

 

Kata Kunci: Bahan Ajar Statistik, Penelitian, Guru IPA. 
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BAB I  

PENDAHULUAN 

 

A. Latar Belakang 

UU No. 14 Tahun 2005 tentang Guru dan Dosen menyatakan bahwa guru mempunyai 

kedudukan sebagai tenaga profesional. Salah satu indikator guru yang professional adalah 

kemampuan dalam melakukan penelitian dan publikasi artikel hasil penelitiannya. Berdasarkan 

Permen PAN-RB Nomor 16 Tahun 2009 Bab VII Pasal 16 ayat 2 terdapat tuntutan bagi guru 

untuk melakukan publikasi ilmiah atau karya inovatif sebagai syarat untuk kenaikan 

jabatan/pangkat. Publikasi ilmiah atau karya inovatif tersebut dapat dikembangkan salah 

satunya dengan penelitian. Data yang berasal dari prosiding seminar nasional pendidikan IPA 

di FMIPA UNY sampai tahun 2016 artikel ilmiah dari guru IPA SMP masih relatif sedikit. 

Penguasaan statistik terapan dalam bidang penelitian pendidikan merupakan salah satu 

faktor untuk meningkatkan kompetensi guru IPA untuk melakukan penelitian. Analisis data 

hasil penelitian sangat membutuhkan penguasaan statistik terlebih penggunaan SPSS. 

Penelitian sederhana atau selevel penelitian eksperimen juga membutuhkan analisis statistik 

misal uji beda, uji korelasi, uji regresi, uji normalitas, dan lain sebagainya sesuai dengan 

variabel yang diteliti. Dalam dunia penelitian dan pendidikan, kebutuhan untuk mengumpulkan 

dan menginterpretasi atau menafsirkan data sudah menjadi kebutuhan yang tidak dapat 

dipisahkan. Berbagai program pengabdian kepada masyarakat (PPM) telah dilakukan oleh 

berbagai perguruan tinggi, namun PPM yang bermuatan penguasaan statistik untuk 

mendukung kompetensi meneliti masih perlu diintensifkan untuk meningkatkan kompetensi 

guru di bidang penelitian kelas. Dengan demikian hal tersebut dapat meningkatkan jumlah 

artikel ilmiah atau penelitian. 

Jumlah artikel ilmiah yang relatif masih sedikit tersebut tentunya banyak faktor 

penyebabnya baik dari internal maupun eksternal guru. Hasil penelitian yang dilakukan oleh 

Zuhdan K.P (2012) dalam mengembangkan KKNI pendidikan fisika menyatakan bahwa 

kompetensi guru masih bervariasi sehingga diperlukan standar kelulusan bagi calon guru saat 

ini. Faktor internal yang menyebakan jumlah publikasi artikel penelitian masih sedikit adalah 

masih rendahnya guru dalam melakukan penelitian disamping penguasaan statistik terapan 

bidang penelitian pendidikan. Faktor eksternal dapat berasal dari masih belum terbentuk 

kominitas guru yang secara rutin melakukan penelitian dan belum optimalnya pelatihan terkait 

dengan penelitian. 
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Guru merupakan kunci dalam peningkatan mutu pendidikan dasar dan menengah, dan 

berada di titik sentral dari setiap usaha -usaha peningkatan mutu pendidikan. Penelitian bagi 

guru dapat digunakan untuk meningkatkan kualitas baik proses pembelajaran maupun evaluasi 

pembelajaran. Perkembangan ICT yang sangat pesat di era digital ini telah melahirkan berbagai 

aplikasi olah data yang dapat digunakan oleh peneliti dengan prosedur yang relatif mudah. 

Aplikasi statsitik yang lazim digunakan oleh peneliti baik penelitian sederhana (sekedar 

mendeskripsikan data) maupun yang bersifat inferensial dapat diselesaikan dengan baik 

melalui SPSS. Disamping itu, berbagai ilmu yang telah dikembangkan oleh para tokoh 

pendidikan perlu disebarluaskan dikalangan pendidikan khususnya kepada guru. Salah satu 

yang dapat diterapkan untuk meningkatkan kompetensi guru dalam melakukan penelitian 

adalah pemanfaatan buku ajar statistik terapan yang disusun oleh Dadan Rosana dan Didik 

Setyawarno untuk penelitian bidang pendidikan dalam program pengabdian kepada 

masyarakat. 

Buku ajar statistik terapan tersebut digunakan dalam perkuliahan statistik terapan di 

program studi Pendidikan IPA FMIPA UNY sejak tahun 2016. Buku ajar tersebut merupakan 

hasil hibah penulisan buku pada tahun 2016. Buku yang bersifat aplikatif telah diujikan dalam 

perkuliahan selama satu semester. Dalam hal ini, langkah awal untuk menumbuhkan minat 

bagi guru untuk melakukan penelitian adalah penguasaan statistik dalam pengolahan data. 

Materi statistik terapan yang dibutuhkan oleh guru perlu menekankan pada bagaimana 

pengolahan data menggunakan SPSS, STATA, dan Software pengolahan data lainnya. 

Berdasarkan uraian di atas, program pengabdian kepada masyarakat (PPM) untuk 

memanfaatkan buku ajar statistik terapan perlu dilakukan dengan tujuan meningkatkan 

kompetensi guru melakukan penelitian. Dengan langkah tersebut diharapkan artikel ilmiah 

hasil penelitian guru dapat meningkat dari tahun ke tahun. 

 

B. Identifikasi dan Perumusan Masalah 

1. Identifikasi Masalah 

Penelitian kelas bagi guru merupakan bagian yang tidak terpisah dalam meingkatkan kualitas 

pendidikan. Hasil penelitian berupa artikel ilmiah merupakan hal yang perlu ditingkatkan 

mengingat masih rendahnya minat guru dalam melakukan penelitian. Disamping itu program 

pelatihan bagi guru untuk meningkatakn kompetensi guru meneliti khususnya penguasaan 

statistik terapan masih perlu digalakkan lagi. Menghadapi persoalan tersebut perlu dilakukan 

program pelatihan bagi guru di bidang penguasaan statistik terapan dengan menggunakan 



3 

 

aplikasi SPSS. 

2. Rumusan Masalah 

Bagaimana meningkatkan penguasaan uji statistik yang bersifat terapan dalam bidang 

penelitian pendidikan bagi guru IPA di Sleman, Yogyakarta dengan menggunakan buku ajar 

statistik terapan? 

 

C. Tujuan Kegiatan 

Tujuan program pengabdian (PPM) ini adalah meningkatkan penguasaan uji statistik 

yang bersifat terapan dalam bidang penelitian pendidikan bagi guru IPA di Sleman, Yogyakarta 

dengan menggunakan buku ajar statistik terapan. 

 

D. Manfaat Kegiatan 

Manfaat dari kegiatan PPM ini adalah guru IPA di Sleman, Yogyakarta memiliki 

penguasaan uji statistik yang bersifat terapan dalam bidang penelitian pendidikan. 
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BAB II  

TINJAUAN PUSTAKA 

 

A. Buku Ajar Statistik Terapan 

Buku ajar statistik terapan yang akan dijadikan bahan pelatihan disusun oleh Dr. Dadan 

Rosana, M.Si dan Didik Setyawarno, M.Pd. Mereka berdua telah memfokuskan dalam bidang 

penelitian dan evaluasi pendidikan IPA. Buku tersebut merupakan hasil hibah penulisan buku 

ajar tahun anggaran 2016 yang akan diterbitkan oleh UNY Press. Buku tersebut dianjurkan 

bagi para mahasiswa khususnya dengan latar belakang non matematika. Secara konten buku 

tersebut membahas konsep dasar statistik bersifat aplikatif yang sering digunakan dalam 

pengujian data penelitian pendidikan. 

Sistematika buku ini meliputi: 1) Pengantar Statistik Terapan, 2) Statistik Deskriptif , 3) 

Uji Prasyarat Analisis, 4) Statistik Parametrik I (One Sample T Test dan Independent Sample 

T-Test ), 5) Statistik Parametrik II (Paired T Test dan Anova: Anova Satu Arah atau One Way 

Anova, Anova Dua Arah Tanpa Interaksi, dan Two-way Analysis of Variance), 6) Statistik 

Nonparametrik I (One Sample Test dalam hal ini digunakan Uji Chi Kuadrat) dan Two 

Independent Samples Test (dalam hal ini digunakan Uji Mann Whitney), 7) Statistik 

Nonparametrik II (Two Related Samples Test dalam hal ini digunakan Uji Wilcoxon dan K- 

Independent Samples Test dalam hal ini digunakan Uji Kruskal Wallis), 8) Analisis Korelasi 

(Korelasi Product Moment dan Korelasi Spearman Rank), 9) Analisis Regresi (Regresi Linier 

Sederhana dan Regresi Linear Ganda), 10) Validitas dan Reliabilitas Instrumen Penelitian, dan 

11) Aplikasi Statistik Berbasis Komputer untuk Analisis Hasil Evaluasi Pembelajaran (Analisis 

Butir Soal dengan Aplikasi Komputer: SPSS, Iteman Versi 4.3 (versi terbaru), AnBuso, dan 

Quest). 

Semua bahasan di atas telah dipadukan dengan penggunaan SPSS versi 22 sebagai alat 

bantu untuk pengujian data. Setelah membaca buku ini, diharapkan pembaca mempunyai 

pemahaman yang lebih menyeluruh tentang analisis data penelitian baik yang bersifat 

deskriptif maupun inferensial. Selain itu, diharapkan pembaca dapat melakukan analisis butir 

soal dengan menggunakanan aplikasi komputer. 

Statistik dalam arti sempit dapat diartikan sebagai data, tetapi dalam arti luas statistik 

dapat diartikan sebagai alat. Alat untuk analisis dan alat untuk membuat keputusan. Statistik 

Terapan merupakan alat analisis dalam bentuk “Numerical Description” untuk menjelaskan 

setiap data yang diperoleh dari populasi dan sampel, untuk kemudian dilakukan perkiraan, 
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peramalan, dan pengambilan keputusan. 

Statistika merupakan salah satu ilmu matematika yang sering digunakan dalam analisis 

data. Statistik adalah alat pengolah kumpulan bahan keterangan (data), baik yang berwujud 

angka (data kuantitatif), maupun yang tidak berwujud angka (data kualitatif) yang mempunyai 

arti penting dan kegunaan yang besar dalam memberikan gambaran tentang suatu keadaan. 

Statistik Terapan menekankan pada bagaimana pengolahan data menggunakan SPSS, 

STATA, dan Software pengolahan data lainnya. Statistik Terapan yang biasa dilakukan oleh 

peneliti baik untuk dunia pendidikan maupun non pendidikan biasanya menggunakan SPSS. 

SPSS (Statistikal Product And Service Solutions) merupakan suatu program komputer statistik 

yang mampu memproses data statistik secara cepat dan tepat, menjadi berbagai output yang 

dikehendaki para pengambil keputusan. Selanjutnya untuk mengetahu elemen statistiknya, 

pada terapannya dikenal dengan 2 pendekatan bagian dari statistik yaitu statistik deskriptif dan 

statistik inferensi. 

Statistik deskriptif lebih berkenaan dengan pengumpulan dan peringkasan data, serta 

penyajian hasil peringkasan tersebut. Data-data statistik, yang bisa diperoleh hasil sensus, 

survei, jajak pendapat atau pengamatan lainnya umumnya masih bersifat acak, “mentah” dan 

tidak terorganisir dengan baik (raw data). Statistik deskriptif menganalisis data populasi 

dengan cara mendeskripsikan atau menggambarkan data yang telah terkumpul, dan tanpa 

membuat kesimpulan yang berlaku umum (generalisasi). 

Statistik inferensial adalah statistik yang menyediakan cara yang dapat dipergunakan 

sebagai alat untuk mencoba menarik kesimpulan yang bersifat umum dari sekumpulan data 

yang telah disusun dan diolah. Statistik inferensial dalam penerapannya lebih luas dari pada 

statistik deskriptif mencakup (a) penarikan kesimpulan (conclusion), (b) penyusunan atau 

pembuatan dugaan (prediction), dan (c) penaksiran atau pendekatan (estimation). Peneliti harus 

lebih dahulu mempelajari statistik deskriptif untuk dapat memahami statistik infrerensial. 

Statistik Inferensi atau induktif berusaha untuk membuat berbagai inferensi terhadap 

sekumpulan data yang berasal dari suatu sampel. Tindakan inferensi tersebut seperti melakukan 

perkiraan, peramalan, dan pengambilan keputusan. 

Statistik inferensial adalah statistik yang digunakan untuk menganalisis data sampel dan 

hasilnya akan digeneralisasikan/diinferensialkan kepada populasi dimana sampel diambil. 

Statistik inferensial ada dua macam, yaitu statistik parametrik dan statistik non parametrik. 

Statistik parametrik mensyaratkan terpenuhinya banyak asumsi, yaitu tentang kenormalan data, 

homogenitas data, dan datanya berupa interval atau rasio, sebaliknya statistik non parametrik 
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tidak memerlukan asumsi-asumsi tersebut. 

 

B. Kompetensi Meniliti 

Kompetensi meneliti merupakan kompetensi yang perlu ditumbuhkan di semua 

kalangan akademisi baik di sekolah maupun di perguruan tinggi. Sesungguhnya terdapat 

beberapa faktor yang berpengaruh terhadap kompetensi peneliti. Secara garis besar terdapat 

dua aspek yang berpengaruh, yaitu aspek internal dan aspek eksternal. Aspek internal 

menunjuk pada dimensi dalam kedirian seseorang. Termasuk dalam aspek ini adalah motivasi. 

Motivasi adalah suatu tenaga atau faktor yang terdapat dalam diri manusia, yang menimbulkan, 

mengarahkan dan mengorganisasikan tingkah lakunya. Tujuan motivasi ini adalah untuk 

menggerakkan atau menggugah seseorang agar timbul keinginan dan kemauannya untuk 

melakukan sesuatu hingga dapat memperoleh hasil atau mencapai tujuan tertentu. 

Selain motivasi, faktor pengetahuan juga merupakan faktor internal penting. 

Pengetahuan menunjuk kepada penguasaan mahasiswa tentang hal-hal yang berkaitan dengan 

teori-teori penelitian itu sendiri. Pengetahuan juga menunjuk kepada penguasaan teoritik atas 

suatu masalah. Teori adalah sekumpulan konsep, definisi, dan proposisi yang menghadirkan 

suatu tinjauan secara sistematis atas fenomena dengan menunjukkan secara spesifik hubungan- 

hubungan antara variabel-variabel yang terkait dalam fenomena, dengan tujuan memberikan 

eksplanasi dan prediksi atas fenomena tersebut. 

Sehubungan dengan variabel dalam penelitian ini, maka penelitian difokuskan kepada 

aspek mengenai penguasaan teori yang relevan, penguasaan metode penelitian (desain, 

sampling, pendekatan, pengumpulan data), penguasaan analisis data, penguasaan implementasi 

penelitian dan penguasaan dalam menyelesaikan laporan penelitian. Ada kompetensi peneliti 

kuantitatif dan kualitatif yang juga perlu diketahui, seperti dijelaskan oleh Sugiyono (2008: 27- 

28). Kompetensi peneliti kuantitatif, yaitu sebagai berikut. 

1. Memiliki wawasan yang luas dan mendalam tentang bidang yang akan diteliti, 

2. Mampu melakukan analisis masalah secara akurat, sehingga dapat ditemukan masalah 

penelitian yang betul-betul masalah, 

3. Mampu menggunakan teori dengan tepat sehingga dapat digunakan untuk memperjelas 

masalah yang diteliti, dan merumuskan hipotesis penelitian, 

4. Memahami berbagai jenis metode penelitian kuantitatif, seperti metode survey, 

eksperimen, ex-post facto, evaluasi dan sejenisnya, 

5. Memahami teknik-teknik sampling, seperti probability sampling dam nonprobability 
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sampling, dan mampu menghitung dan memilih jumlah sampel yang representatif dengan 

sampling error tertentu, 

6. Mampu menyusun instrumen untuk mengukur berbagai variabel yang diteliti, mampu 

menguji validitas dan reliabilitas instrumen, 

7. Mampu mengumpulkan data dengan kuesioner, maupun dengan wawancara dan observasi, 

8. Bila mengumpulkan data dilakukan oleh tim, maka harus mampu mengorganisasikan tim 

peneliti dengan baik, 

9. Mampu menyajikan data, menganalisis data secara kuantitatif untuk menjawab rumusan 

masalah dan menguji hipotesis penelitian yang telah dirumuskan, 

10. Mampu memberikan interpretasi terhadap data hasil penelitian maupun hasil pengujian 

hipotesis, 

11. Mampu membuat laporan secara sistematis, dan menyampaikan hasil penelitian ke pihak- 

pihak terkait, 

12. Mampu membuat abstraksi hasil penelitian dan membuat artikel untuk dimuat dalam jurnal 

ilmiah. 

Kompetensi peneliti kualitatif sebagai berikut. 

1. Mewakili wawasan yang luas dan mendalam tentang bidang yang akan diteliti, 

2. Mampu menciptakan rapport kepada setiap orang yang ada pada konteks social yang akan 

diteliti. Menciptakan rapport berarti mampu membangun hubungan yang akrab dengan 

setiap orang yang ada pada konteks soail, 

3. Memiliki kepekaan untuk melihat setiap gejala yang ada pada objek penelitian (konteks 

sosial), 

4. Mampu menggali sumber data dengan observasi partisipan, dan wawancara mendalam 

secara triangulasi, serta sumber-sumber lain, 

5. Mampu menganalisis data kualitatif secara induktif berkesinambungan mulai dari analisis 

deskriptif, domain, komponensial, dan tema cultural atau budaya, 

6. Mampu menguji kredibilitas, dependabilitas, konfirmabilitas, dan transferabilitas hasil 

penelitian, 

7. Mampu menghasilkan temuan pengetahuan, hipotesis atau ilmu baru, 

8. Mampu membuat laporan secara sistematis, jelas, lengkap dan rinci. 

Berdasarkan uraian tentang kompetensi penelitian dan kompetensi peneliti di atas 

dikaitkan dengan peran guru untuk melakukan penelitian secara garis besar dapat disimpulkan 
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sebagai berikut: (1) kompetensi dalam menguasai teori yang relevan; (2) kompetensi dalam 

menguasai metode penelitian: desain, sampling, pendekatan dan pengumpulan data; (3) 

kompetensi dalam menguasai cara menganalisa data, dan menginterpresentasi data; (4) 

kompetensi dalam menguasai implementasi penelitian, dan (5) kompetensi dalam menyusun 

laporan penelitian. Dari uraian tersebut, menunjukkan bahwa statistika memiliki arti yang 

sangat penting bagi guru dalam membantu di bidang penelitian. 
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BAB III  

METODE KEGIATAN 

 

A. Metode Kegiatan 

Kegiatan PPM yang akan dilaksanakan adalah kegiatan pelatihan yang ditujukan bagi 

guru-guru IPA tingkat SMP di Sleman, Yogyakarta. Uraian dari kegiatan pelatihan meliputi: 

1. penyampaian materi yang meliputi konsep dasar statistik kaitannya dengan penelitian, 

2. materi panduan dasar uji statistik dalam penelitian bidang pendidikan, dan 

3. praktek menggunakan aplikasi SPSS untuk uji statistik. 

 

 

B. Kalayak dan Tempat Kegiatan 

Kegiatan PPM ini diperuntuk bagi guru-guru IPA di Sleman, Yogyakarta. Pelaksanaan 

kegiatan ini akan disatukan dengan agenda kegiatan MGMP guru IPA di Sleman, Yogyakarta 

yang dilakukan secara rutin. 

 

C. Kerangka Pemecahan Masalah 

Masalah penguasaan uji statistik yang belum optimal bagi guru IPA merupakan 

persoalan yang harus diatasi dalam rangka menumbuhkan kompetensi guru untuk melakukan 

penelitian. Permasalahan tersebut dapat diselesaikan dengan dilakukan beberapa hal sebagai 

berikut: 

1. Memberikan pemahaman secara utuh tentang keterkaitan antara statistik dengan 

penelitian. 

2. Memberikan pelatihan konsep dasar statistik berikut aplikasi pengujiannya dalam 

berbagai jenis penelitian. 

3. Memberikan pengalaman langsung bagi guru untuk menggunakan aplikasi SPSS untuk uji 

statistik. 

Ketiga kegiatan tersebut dapat dilaksanakan dengan baik dengan berbagai pertimbangan 

yaitu penggunaan waktu jauh lebih efisien dan dapat dipraktekkan langsung di sekolah setelah 

pelatihan selesai dilaksanakan. Pada saat pelaksanaan, monitoring, evaluasi dan refleksi 

dilaksanakan terus menerus untuk mencapai hasil kegiatan yang maksimal. Secara rinci, alur 

pemecahan masalah digambarkan dengan diagram berikut ini. 
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Gambar 1. Alur Pemecahan Masalah 

 

Bentuk kegiatan PPM yang akan dilaksanakan berdasarkan alur pemecahan masalah di 

atas sebagai berikut. 

1. Tutorial: materi 1 adalah peranan statistik dalam bidang penelitian pendidikan. 

2. Tutorial: materi 2 adalah panduan penggunaan aplikasi SPSS untuk melakukan berbagai 

uji statistik. 

3. Praktik: penggunaan aplikasi SPSS untuk uji statistik dalam bidang penelitian 

pendidikan. 

4. Tugas Terstruktur: 

a. Penyusunan judul penelitian dan jenis uji statistik yang akan digunakan. 

b. Melakukan uji statistik dengan aplikasi SPSS yang berkaitan dengan data penelitian 

bidang pendidikan. 

5. Konsultasi Tugas: konsultasi dilakukan via email/HP, khususnya bagi peserta pelatihan 

yang mengalami kesulitan dalam menyelesaian tugas terstruktur. 
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D. Rancangan Evaluasi 

Evaluasi dan refleksi kegiatan pelatihan dilakukan secara menyeluruh baik sebelum 

maupun setelah program selesai. Tim PPM akan melihat kondisi awal guru tentang penelitian 

dan uji statistik yang telah mereka dengan menggunakan angket. Demikian juga untuk 

mengetahui tanggapan peserta pelatihan terkait dengan kegiatan yang telah dilaksanakan oleh 

Tim PPM. Penguasaan guru dalam menggunakan aplikasi SPSS dilihat ketika sesi praktik dan 

laporan tugas yang telah dikumpulkan. Selain itu, sertifikat hasil pelatihan akan diberikan 

ketika laporan sudah dikumpulkan ke Tim PPM dengan kategori cukup, baik, dan sangat baik. 

 

E. Organisasi Pelaksana 

1. Ketua Tim Pelaksana 

a. Nama dan Gelar Akademik : Drs. Eko Widodo, M.Pd b.   

b. NIP : 19591212 198702 1 001 

c. Jabatan Fungsional : Lektor 

d. Jabatan Struktural : Koordinator PPL 

e. Program Studi : Pendidikan IPA 

f. Waktu yang disediakan : 3 Jam/Minggu. 

2. Anggota 1 

a. Nama dan Gelar Akademik : Dr. Dadan Rosana, M.Si b.   

b. NIP : 19690202 199303 1 002 

c. Jabatan Fungsional : Lektor Kepala 

d. Jabatan Struktural : Ketua Jurusan Pendidikan IPA 

e. Program Studi : Pendidikan IPA 

f. Waktu yang disediakan : 3 Jam/Minggu 

3. Anggota 2 

a. Nama dan Gelar Akademik : Didik Setyawarno, M.Pd b.   

b. NIP : 19881013 201504 1 004 

c. Jabatan Fungsional : Tenaga Pengajar 
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d. Program Studi : Pendidikan IPA 

e. Waktu yang disediakan : 3 Jam/Minggu 

4. Mahasiswa 1 

a. Nama : Thifli Habibi 

b.  NIM : 14312241015 

c. Fakultas/Jurusan/Prodi : MIPA/Pendidikan IPA/Pendidikan IPA 

d. Tugas/Aktivitas dalam PPM : Teknis Lapangan 

5. Mahasiswa 2 

a. Nama : Trian Anugrah 

b.  NIM : 14312241050 

c. Fakultas/Jurusan/Prodi : MIPA/Pendidikan IPA/Pendidikan IPA 

d. Tugas/Aktivitas dalam PPM : Teknis Lapangan 
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BAB IV 

PELAKSANAAN KEGIATAN PENGABDIAN 

 

A. Pengantar 

PPM yang telah dilaksanakan ini merupakan PPM berbasis pelatihan yang bersifat 

aplikatif bagi Guru SMP di Sleman. Sebelum PPM dilaksanakan, TIM PPM melakukan 

koordinasi persiapan segala sesuatu yang dibutuhkan untuk kegiatan baik sebelum maupun saat 

pelaksanaan. Persiapan yang dilakukan oleh Tim PPM mencakup aspek akademik, 

administrasi, dan non-akademik. Aspek akademik yang disiapakan meliputi: pemateri utama, 

makalah/materi dalam bentuk ppt, komputer (bagi peserta pelatihan disediakan komputer di 

laboratorium komputer IPA), dan lembar penilaian/monitoring. Persiapan administrasi 

mencakup lembar presensi, keperluan pertanggungjawaban keuangan, dan sertifikat untuk 

peserta. Persiapan non- akademik mencakup ruang, LCD, dan konsumsi. Tim PPM dalam hal 

ini terdiri dari dosen, mahasiswa, dan laboran Lab. IPA. 

 

B. Waktu dan Susunan Acara Pelaksanaan Pengabdian 

Persiapan, pelatihan dan pelaporan direncanakan akan dilaksanakan selama 3 bulan 

(Agustus, September, dan Oktober 2017) dengan perincian sebagai berikut: 

Tabel 4.1. Jadwal Pelaksanaan PPM. 

 

 

No 

 

Jenis kegiatan 

Minggu ke 

1 2 3 4 5 6 7 8 9 10 11 12 

1 Koordinasi Tim (Penentuan 

peserta pelatihan dan tempat 

pelatihan) 

            

2 Persiapan materi pelatihan             

3 Penyebaran undangan peserta 

pelatihan 

            

4 Pendaftaran Peserta             

5 Pelatihan             

6 Evaluasi Peserta Pelatihan             

7 Evaluasi PPM             

8 Pelaporan             
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Pelaksanaan PPM pada hari Sabtu, 9 September 2017, di Laboratorium Komputer Jurusan 

Pendidikan IPA FMIPA UNY, mulai pukul 07.00 – 11.30. Rincian susunan acara pelaksanaan 

pelatihan sebagai berikut. 

Tabel 4.2. Susunan Acara Pelatihan 

 

No Waktu Acara Penanggung Jawab 

1. 07.00 - 07.30 Persiapan dan Registrasi Peserta Tim 

2. 07.30 – 08.00 Pembukaan Eko Widodo, M.Pd 

3. 08.00 – 09.00 Materi 1: Uji statistik dalam penelitian 
Pendidikan 

Eko Widodo, M.Pd 

4. 09.00 – 09.15 Istirahat - 

5. 09.15 – 10.15 Materi 2: Aplikasi SPSS untuk uji 
statistik 

Didik Setyawarno, M.Pd 

6. 10.15-11.00 Diskusi dan Tanya Jawab Tim 

7. 11.00-11.30 Penutupan Eko Widodo, M.Pd 

 

Kegiatan PPM berupa pelatihan dan workshop penggunaan bahan ajar mata kuliah 

“Statistik Terapan” untuk uji statistik dalam penelitian pendidikan dan tugas 

mandiri/terstruktur yang diberikan selama 1 bulan. 

 

C. Tempat Pelaksanaan Program Pengabdian kepada Masyarakat (PPM) 

Pelatihan dilakukan di Laboratorium Komputer Jurusan Pendidikan IPA FMIPA, UNY, 

dilanjutkan dengan bimbingan terstruktur dengan on-line atau e-mail bagi peserta yang 

mengalami kesulitan dalam menyelesaiakan tugas. 

 

D. Peserta Pengabdian 

Pelatihan ini diikuti oleh 10 peserta dari target 20 peserta dari guru-guru IPA SMP di 

Sleman, Yogyakarta. Dengan berbagai keterbatasan maka peserta dibatasi sebanyak 20 orang 

saja. Pembatasan terkait dengan alokasi dana yang terbatas, dan keterbatasan sarana dan 

prasarana yang dimiliki (Lampiran 3). 

 

E. Metode Pembinaan Pengabdian: 

Kegiatan PPM dilaksanakan dengan cara tutorial (Tatap Muka), workshop, penugasan 

terstruktur, dan konsultasi sebagai berikut. 

1. Tutorial dan workshop: materi 1 adalah uji statistik dalam penelitian Pendidikan. 

2. Tutorial dan workshop: materi 2 adalah aplikasi SPSS untuk uji statistik. 

3. Tugas Terstruktur: 

a. Melakukan uji statistik prasyarat analisis. 
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b. Melakukan uji beda atau uji t dengan aplikasi SPSS. 

4. Konsultasi Tugas: konsultasi dilakukan via email/HP, khususnya bagi peserta pelatihan 

yang mengalami kesulitan dalam menyelesaian tugas terstruktur. 

 

F. Hasil Kegiatan: 

Dari pelatihan ini dihasilkan beberapa hal sebagai berikut: 

1. Guru mampu memiliki pemahaman dasar dalam uji statistik untuk penelitian pendidikan. 

2. Guru  mampu memiliki kemampuan menggunakan aplikasi SPSS dalam uji statistik. 

 

G. Tanggapan Guru: 

Sebelum pelatihan diakhiri, Tim PPM meminta tanggapan dari peserta pelatihan secara 

lisan dan lembar isian terhadap kegiatan pelatihan yang telah dilaksanakan. Secara ringkas hasil 

tanggapan guru dapat disimpulkan baik dan mendukung kompetensi guru untuk melakukan 

penelitian di kelas baik dengan model eksperimen maupun penelitian tindakan kelas. Hasil 

analisis lembar isian menyatakan bahwa kegiatan PPM sangat dibutuhkan oleh peserta 

pelatihan/ guru untuk memenuhi salah satu kewajiaban dalam kenaikan pangkat. Peserta 

pelatihan menyatakan terbantu dengan adanya kegiatan pelatihan ini. Hasil analisis tugas 

terkait uji statistik dengan aplikasi SPSS menunjukkan bahwa peserta mampu menggunakan 

dengan baik dan membaca hasil analisis dengan baik. Harapan peserta pelatihan adalah 

kegiatan ini bisa dilanjutkan di waktu lain dengan tema yang serupa terkait dengan 

pengembangan penelitian di sekolah. 

 

H. Faktor Pendukung dan Penghambat 

1. Faktor Pendukung : 

a. Jumlah komputer lebih dari cukup, sehingga semua satu peserta menggunakan satu 

komputer. 

b. Motivasi peserta untuk menjadi guru IPA yang professional yang ditandai dengan 

banyak peserta yang bertanya selama pelatihan. 

c. Kepakaran tim pengabdi sesuai dengan program pelatihan yang diselenggarakan. 

2. Faktor Penghambat 

a. Padatnya jadwal guru di sekolah, sehingga susah menentukan jadwal pelatihan. 

b. Hari pelaksanaan PPM bersamaan dengan agenda Dinas Pendidikan sedingga peserta 

yang mengikuti pelatihan di bawah target. 
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BAB V 

PENUTUP 

 

 

A. Kesimpulan 

Berdasarkan uraian sebelumnya dapat disimpulkan bahwa Program Pengabdian (PPM) 

telah terlaksana dengan hasil yang baik. Hasil penilaian melalui lisan, lembar isian, serrta hasil 

pengumpulan tugas terstruktur dari guru-guru peserta pelatihan, dapat disimpulkan bahwa 

PPM  dengan yang dilakukan melalui pemanfaatan buku ajar statistik terapan dan dapat 

meningkatkan kompetensi bagi guru IPA dalam analisis data hasil penelitian bidang 

pendidikan. Materi yang di susun oleh Tim mudah dipahami oleh peserta pelatihan dan berguna 

untuk meningkatkan kompetensi guru dalam melakukan penelitian pendidikan. 

 

B. Rekomendasi 

Kemampuan dan ketrampilan guru IPA dalam melakukan penelitian di kelas saat ini perlu 

didukung oleh penguasaan uji statistik yang memadahi. Penguasaan tersebut menjadi dasar 

untuk penyusunan karya ilmiah bagi guru. Berdasar fakta-fakta tersebut di atas maka 

direkomendasikan beberapa hal sebagai berikut. 

1. Kegiatan PPM dilakukan secara rutin dilaksanakan untuk topik yang berbeda dengan 

diperluas sasaran dan wilayahnya. 

2. Perlu dilakukan pelatihan pengelolaan laboratorium IPA 

3. Pelatihan dengan memanfaatan ICT untuk pembelajaran 

4. Pelatihan bedah soal/ kisi-kisi soal Olimpiade Sains SMP. 

5. Perlu diintensifkan kemitraan antara FMIPA UNY dengan Pemda Propinsi atau 

Kabupaten/Kota dalam program pre-service, in-service maupun on-service training, 

sehingga akan terbentuk mutual relationship antar institusi yang terlibat. 
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BAB I 

UJI PRASYARAT ANALISIS 

 

A. Uji Prasyarat Analisis 

Uji persyaratan analisis diperlukan untuk mengetahui apakah analisis data untuk 

pengujian   hipotesis   dapat   dilanjutkan   atau   tidak.   Beberapa   teknik   analisis   data 

menuntut uji persyaratan analisis. Misal, analisis varian mempersyaratkan bahwa data berasal 

dari   populasi   yang   berdistribusi   normal   dan   kelompok-kelompok   yang   dibandingkan 

homogen.   Oleh   karena   itu   analisis   varian   mempersyaratkan   uji   normalitas   dan 

homogenitas data. Bagian ini akan dibahas secara singkat terkait uji normalitas dan uji 

homogenitas. 

Uji normalitas data adalah bentuk pengujian tentang kenormalan distribusi data. Tujuan 

dari uji ini adalah untuk mengetahui apakah data yang terambil merupakan data terdistribusi 

normal atau bukan. Maksud dari terdistribusi normal adalah data akan mengikuti bentuk 

distribusi normal di mana data memusat pada nilai rata-rata dan median. Uji normalitas adalah 

uji yang dilakukan untuk mengecek apakah data penelitian kita berasal dari populasi yang 

sebarannya normal. Uji ini perlu dilakukan karena semua perhitungan statistik parametrik.  

Pada dasarnya uji homogenitas dimaksudkan untuk memperlihatkan bahwa dua atau 

lebih kelompok data sampel berasal dari populasi yang memiliki variansi yang sama. Pada 

perkuliahan ini akan dikenalkan salah satu uji homogenitas yang sering digunakan dalam 

penelitian yaitu uji levene. 

  



 

B. Aplikasi SPSS untuk Uji Normalitas 

Berikut ini disajikan data tentang pre test, motivasi belajar, dan post test hasil belajar IPA SMP 

kelas VII.  

Motivasi Pre Test Post Test 

78 30 89 

69 21 76 

56 15 65 

50 17 66 

55 18 68 

60 19 69 

80 33 90 

65 20 68 

66 21 70 

60 20 70 

73 23 72 

57 19 67 

59 18 68 

63 22 71 

79 32 90 

68 22 78 

58 18 68 

52 18 67 

57 16 70 

59 18 65 

82 32 86 

64 22 69 

66 20 70 

63 24 68 

74 25 70 

58 18 65 

56 20 64 

65 22 56 

61 19 60 

64 26 70 

 

1. Prosedur Analisis 

a. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

b. Isikan di kolom Name “Motivasi” di baris pertama dengan decimals bernilai 2, 

“PresTest” di baris ke dua dengan decimals bernilai 2, dan PostTest di baris ke tiga 

dengan decimals bernilai 2.  

 
c. Pilih Data View dan masukan nilai motivasi belajar, pre test, dan post test sebagai 

berikut. 

Ujilah apakah ketiga variabel di atas 

memiliki distribusi normal? Ujilah 

dengan menggunakan taraf 

signifikansi 5%! 

 



 

 
d. Lakukan analisis dengan menggunakan menu Analyze → Non Parametric Test → 

Legacy Dialogs → 1 Sample K-S. Masukan semua variabel ke kotak Test Variable 

List. 

 
e. Klik OK sehingga muncul hasil analisis sebagai berikut. 

One-Sample Kolmogorov-Smirnov Test 

 Motivasi PresTest PostTest 

N 30 30 30 

Normal Parametersa,b Mean 63.9000 21.6000 70.8333 

Std. Deviation 8.39684 4.77493 8.22982 

Most Extreme Differences Absolute .135 .200 .274 

Positive .135 .200 .274 

Negative -.087 -.125 -.139 

Test Statistic .135 .200 .274 

Asymp. Sig. (2-tailed) .174c .004c .000c 

a. Test distribution is Normal. 

b. Calculated from data. 

c. Lilliefors Significance Correction. 

 

  



 

2. Pembacaan Hasil Analisis 

Tabel One-Sample Kolmogorov-Smirnov Testmenunjukkan hasil analisis uji normalitas 

terhadap ketiga variabel tersebut. 

Hipotesis Penelitian : 

Ho  : Sampel berdistribusi normal. 

H1  : Sampel berdistribusi tidak normal. 

Ketentuan 
Jika Asymp.Sig (2-tailed) ≥ ½ α, maka Ho diterima. 

Jika Asymp. Sig (2-tailed) < ½ α, maka Ho ditolak. 

 

Berdasarkan hasil analisis di atas diperoleh : 

1) Motivasi dengan Asymp.Sig (2-tailed = 0,174) ≥ ½ α (0,05) sehingga berdistribusi 

normal. 

2) Pre Test dengan Asymp.Sig (2-tailed = 0,004) < ½ α (0,05) sehingga berdistribusi tidak 

normal. 

Post Test dengan Asymp.Sig (2-tailed = 0,000) < ½ α (0,05) sehingga berdistribusi tidak 

normal. 

 

C. Aplikasi SPSS untuk Analisis Homogenitas 

Perhitungan uji homogenitas menggunakan software SPSS adalah dengan Uji Levene 

statistics. Cara menafsirkan uji levene ini adalah, jika nilai Levene statistic > 0,05 maka dapat 

dikatakan bahwa variasi data adalah homogen.  

Dibawah ini terdapat data Skor Tes Kemampuan Pemahaman Siswa 

Siswa Eksperimen Kontrol  Siswa Eksperimen Kontrol 

S-01 4 6  S-11 4 8 

S-02 9 4  S-12 7 5 

S-03 11 6  S-13 13 12 

S-04 13 12  S-14 16 10 

S-05 5 7  S-15 10 4 

S-06 11 14  S-16 4 5 

S-07 4 13  S-17 2 4 

S-08 5 10  S-18 19 15 

S-09 9 10  S-19 15 11 

S-10 11 13  S-20 8 10 

 

  



 

Berikut adalah Langkah-langkahnya: 

a. Buka SPSS 

b. Copy data tersebut ke dalam lembar kerja SPSS letakan dalam satu kolom dan perlu diingat 

no urutnya 1-20 adalah kelas eksperimen dan 21-40 kelas kontrol, kemudian pada kolom 

kedua isi dengan “1” untuk kelas Eksperimen dan “2” untuk kelas kontrol. 

 
 

c. Buka Data View, pilih baris “kelas” dan isi kolom Value  dengan “1”, Label dengan 

“Eksperimen” kemudian klik Add, kemudian lanjutkan isi kolom Value  dengan “2”, Label 

dengan “Kontrol” kemudian klik Add dan klik OK. 

 
 

d. Lakukan pengujian homogenitas dengan uji Lavene Statistic dengan cara memilih menu : 

analyze, compare means, one-way anova. 

 
 

e. Masukan “skor” ke kotak Dependen List dan “kelas” ke kotak Factor. 



 

 
 

f. Klik menu  Option dan pilih Homogenity of variance test, kemudian klik Continue. 

 
 

g. Kemudian klik Ok sehingga muncul hasil: 

 Test of Homogeneity of Variances 
skor   

Levene 

Statistic df1 df2 Sig. 

.893 1 38 .351 

 

Ketentuan 
Jika nilai Sig ≥  α, maka Ho diterima. 

Jika nilai Sig <  α, maka Ho ditolak. 

 

Kerena p-value (sig) = 0,351 > 0,05 maka data siambil dari sampel yang homogen. 

 

  



 

BAB II 

STATISTIK PARAMETRIK  

 

A. One Sample T Test dan Independent T Test 

Salah satu bagian penting dalam ilmu statistik adalah persoalan inferensi yaitu penarikan 

kesimpulan secara statistik. Dua hal pokok yang menjadi pembicaraan dalam statistik inferensi 

adalah penaksiran parameter populasi dan uji hipotesis. Teknik inferensi yang pertama 

dikembangkan adalah mengenai pembuatan sejunlah besar asumsi sifat populasi di mana 

sampel telah diambil. Teknik yang banyak digunakan pada metode-metode pengujian hipotesis 

dan penaksiran interval ini kemudian dikenal sebagai Statistik Parametrik, karena harga-harga 

populasi merupakan parameter. Ditribusi populasi atau distribusi variabel acak yang digunakan 

pada teknik inferensi ini mempunyai bentuk matematik yang diketahui, akan tetapi memuat 

beberapa parameter yang tidak diketahui.  

One Sample T Test adalah uji komparatif untuk menilai perbedaan antara nilai tertentu 

dengan rata-rata kelompok populasi. One sample t test disebut juga dengan istilah student t test 

atau uji t satu sampel oleh karena uji t di sini menggunakan satu sampel. Independent sample t 

test adalah uji dengan dua sampel. Independen T Test adalah uji komparatif atau uji beda untuk 

mengetahui adakah perbedaan mean atau rerata yang bermakna antara 2 kelompok bebas yang 

berskala data interval/rasio. Dua kelompok bebas yang dimaksud di sini adalah dua kelompok 

yang tidak berpasangan, artinya sumber data berasal dari subjek yang berbeda. Misal 

Kelompok Kelas A dan Kelompok kelas B, di mana responden dalam kelas A dan kelas B 

adalah 2 kelompok yang subjeknya berbeda.  

  



 

1. One Sample T Test dengan SPSS 

Sebelum mengolah data dengan menggunakan SPSS, masukan dulu data kedalam SPSS. 

a. Klik Variabel View pada sebelah kiri bawah jendela SPSS. 

b. Masukan data seperti dibawah gambar dibawah ini : 

 
c. Setelah itu masukan data isi botol diatas pad Data View yang ada di kiri bawah, seperti 

jendela dibawah ini : 

 
d. Pilih Analyze untuk memulai t-test, pada sub menu pilih Compare Means kemudian 

pilih One-Sample T-Test seperti dibawah ini: 

 
e. Akan muncul jendela One Sample T-Test, pindahkan variabel botol ke test variabel 

dengan memilih variabel botol kemudian klik tanda panah ke kanan di jendela tersebut. 

Dan isikan test Value dengan T hitung yang dijadikan perbandingan. 

f. Klik Option pada jendela One Sample T-Test kemudian muncul jendela berikutnya. 

Isikan derajat keyakinan sebesar 95%  (α = 55) 



 

 
g. Klik Continue kemudian Ok akan muncul jendela hasil yang menampilkan text dan 

tabel seperti dibawah ini : 
 

T-Test 

[DataSet0]  

One-Sample Statistics 

 N Mean Std. Deviation Std. Error Mean 

B

o

t

o

l 

20 100.45 2.544 .569 

 

One-Sample Test 

 Test Value = 100 

T df Sig. (2-tailed) Mean Difference 95% Confidence Interval of the 

Difference 

Lower Upper 

B

o

t

o

l 

.791 19 .439 .450 -.74 1.64 

 

h. Kesimpulan 

Dari output kedua diperoleh nilai t hitung SPSS = 0,791. Sedangkan nilai -𝑡𝛼 2⁄  dan 𝑡𝛼 2⁄  

adalah -2,093 dan 2,093. Jika dibandingkan, maka t hitung SPSS berada di antara 

angka-angka t tabel, sehingga Ho diterima. Karena Sig. (2-tailed) > 0,05 maka H0 

diterima. 

Oleh karena dapat diambil keputusan bahwa dengan tingkat kepercayaan 95%, secara 

signifikan hasil pengujian tidak berbeda dengan apa yang diklaim oleh perusahaan 

pembuat mesin pengisi botol. 

  



 

2. Independent sample t test dengan SPSS 

Berikut ini disajikan data IPK mahasiswa kelas A yang (pembelajaran ceramah) dengan Kelas 

B (pembelajaran berbasis media komputer) dengan pembelajaran inkuiri. 

Nilai IPA 

Kelas A Kelas B 

3.12 3.29 

3.33 2.89 

3.40 3.48 

3.21 3.75 

2.98 3.33 

3.02 2.87 

3.66 3.27 

3.51 3.87 

 3.23 

 3.12 

 3.04 

 

Ujilah apakah kedua kelas memiliki varian yang sama? 

Ujilah apakah ada perbedaan IPK antara mahasiswa kelas A dan kelas B? Jika ada 

perbedaan, manakah yang memiliki IPK lebh tinggi?  

(Gunakan taraf signifikansi 5%) 

Prosedur Analis 

a. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

b. Isikan di kolom Name “Kelas” di baris pertama dengan decimals bernilai 0, dan “IPK” 

di baris ke dua dengan decimals bernilai 2.  

 
c. Pilih Data View di samping Variable View dan masukan data IPK  dengan indeks 1 

untuk kelas A dan indeks 2 untuk kelas B serta masukan semua nilainya. 

 
d. Pilih menu Analyze → Compare Mean → Independent-Samples T Test. 

e. Masukan variabel Nilai ke Test Variable(s) dan Kelas ke Grouping Variable. 



 

 
f. Klik tombol Define Groups dan isikan 1 di Group 1 dan 2 di Group 2 dan klik tombol 

continue.  

 
g. Klik OK sehingga muncul hasil sebagai berikut. 



 

Output SPSS untuk Independent Samples T Test. 
 

 
Independent Samples Test 

 

Levene's Test for Equality of 
Variances t-test for Equality of Means 

F Sig. t Df 
Sig. (2-
tailed) 

Mean 
Difference 

Std. Error 
Difference 

95% Confidence Interval of the 
Difference 

Lower Upper 

Nilai Equal variances assumed 2.835 .111 -5.845 17 .000 -.77670 .13288 -1.05705 -.49636 

Equal variances not assumed   -5.261 9.369 .000 -.77670 .14763 -1.10868 -.44473 

 

 

Group Statistics 

 Kelas N Mean Std. Deviation Std. Error Mean 

Nilai 1 8 2.9788 .38632 .13658 

2 11 3.7555 .18587 .05604 



 

h. Pembacaan hasil analisis dan kesimpulan. 

1) Tabel Independent Samples Test menampilkan uji varian kedua kelompok dan 

perbedaan.  

F test digunakan untuk menguji asumsi dasar dari t test bahwa varian kedua kelompok 

sama. 

Hipotesis Penelitian : 

Ho : kedua kelompok memiliki varian yang sama (homogen). 

H1 : kedua kelompok memiliki varian yang tidak sama  (tidak homogen). 

Ketentuan 

Jika F hitung < F table, maka Ho diterima. 

Jika F hitung > F table, maka Ho ditolak. 

Atau 

Jika Sig > α, maka Ho diterima. 

Jika Sig < α, maka Ho ditolak. 

 

Nilai Sig (0,111) > α (0,05), maka Ho diterima. Jadi kedua kelompok memiliki varian yang 

sama  (homogen). 

 

Uji selanjutnya memakai nilai pada baris bagian atas (equal variances assumed), namun 

apabila pada perhitungan Sig < α maka memakai nilai baris yang bawah. 

Hipotesis Penelitian : 

Ho  : jenis pembelajaran tidak berpengaruh terhadap IPK mahasiswa. 

H1   :  jenis pembelajaran berpengaruh terhadap IPK mahasiswa. 

Ketentuan 

Jika t hitung < t table, maka Ho diterima. 

Jika t hitung > t table, maka Ho ditolak. 

Atau 

Jika Sig (2-tailed) > ½ α, maka Ho diterima. 

Jika Sig (2-tailed) < ½ α, maka Ho ditolak. 

 

Nilai t hitung kecil dan nilai Sig (2-tailed = 0,000) < ½ α (0,05) maka Ho ditolak. Jadi jenis 

pembelajaran yang digunakan dalam pembelajaran berpengaruh pada IPK mahasiswa. 

  



 

B. Paired T Test dan Anova 

Analisis paired-sample t-test merupakan prosedur yang digunakan untuk 

membandingkan rata-rata dua variabel dalam satu group. Analisis ini digunakan untuk 

melakukan pengujian terhadap satu sampel yang mendapatkan sata treatment yang kemudian 

akan dibandingkan rata-rata dari sampel tersebut antara sebelum dan sesudah treatment.  

Analisis varians (analysis of variance) atau ANOVA adalah suatu metode analisis 

statistika yang termasuk ke dalam cabang statistika inferensi. Uji dalam anova menggunakan 

uji F karena dipakai untuk pengujian lebih dari 2 sampel. Dalam praktik, analisis varians dapat 

merupakan uji hipotesis (lebih sering dipakai) maupunpendugaan (estimation, khususnya di 

bidang genetika terapan). 

1. Paired T Test dengan SPSS 

a. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

b. Isikan di kolom Name “PreTest” di baris pertama dengan decimals bernilai 2, dan 

“PostTest” di baris ke dua dengan decimals bernilai 2.  

 
c. Pilih Data View dan masukan data pre test dan post test sebagai berikut. 

 
 

d. Pilih menu Analyze → Compare Mean → Paired-Samples T Test. 

 
 

e. Masukan variabel PreTest dan PostTest ke kotak Paired Variables. 



 

 
 

f. Klik OK sehingga muncul hasil sebagai berikut. 

 
 

 

 



 

Output SPSS untuk Paired Samples T Test. 

 
Paired Samples Statistics 

 Mean N Std. Deviation Std. Error Mean 

Pair 1 PreTest 40.4000 10 6.00370 1.89854 

PostTest 72.0000 10 6.68331 2.11345 

 

Paired Samples Correlations 

 N Correlation Sig. 

Pair 1 PreTest & PostTest 10 .817 .004 

 

Paired Samples Test 

 

Paired Differences 

t df Sig. (2-tailed) Mean Std. Deviation Std. Error Mean 

95% Confidence Interval of the 

Difference 

Lower Upper 

Pair 1 PreTest – PostTest -31.60000 3.89301 1.23108 -34.38489 -28.81511 -25.669 9 .000 



 

g. Pembacaan Hasil Analisis 

a. Tabel Paired Samples Correlations menampilkan uji korelasi nilai pre test dan post 

test. 

Hipotesis Penelitian: 

Ho  : Tidak ada hubungan antara pre test dan post test dengan pembelajaran 

inkuiri. 

H1  : Ada hubungan antara pre test dan post test dengan pembelajaran inkuiri. 

Ketentuan penerimaan/penolakan hipotesis sebagai berikut. 

thitung < ttabel, maka Ho diterima 

thitung > ttabel, maka Ho ditolak 

Atau  

Jika Sig > α, maka Ho diterima. 

Jika Sig < α, maka Ho ditolak. 

Kesimpulan: 
Nilai Sig (0,004) < α (0,05), maka Ho ditolak. Jadi ada hubungan antara pre test dan post test 

dengan pembelajaran inkuiri dengan tingkat hubungan/korelasi cukup besar, yaitu 0,817. 

b. Tabel Paired Samples Test menampilkan uji beda nilai pre test dan post test sesudah 

perlakuan/pembelajaran inkuiri. 

Hipotesis Penelitian: 

Ho  :  Tidak ada perbedaan antara pre test dan post test dengan pembelajaran 

inkuiri. 

H1  : Ada perbedaan antara pre test dan post test dengan pembelajaran inkuiri. 

Ketentuan penerimaan/penolakan hipotesis sebagai berikut. 

thitung < ttabel, maka Ho diterima 

thitung > ttabel, maka Ho ditolak 

Atau 

Jika Sig (2-tailed) >½ α, maka Ho diterima. 

Jika Sig (2-tailed) <½ α, maka Ho ditolak. 

Kesimpulan 

Nilai Sig (2-tailed = 0,000) <½ α (0,025), maka Ho ditolak. Jadi ada perbedaan nilai 

pre test dan post test sesudah perlakuan/pembelajaran inkuiri. Dengan kata lain 

pembelajaran inkuiri berpengaruh terhadap hasil post test. 

2. Anova dengan SPSS 

Berikut ini disajikan data skore TOEFL Mahasiswa Pendidikan IPA yang mengikuti kursus 

bahasa Inggris. 

Sampel 
Lama Kursus 

3 bulan 6 bulan 9 bulan 

1 423 444 478 

2 410 459 480 

3 421 440 494 

4 428 435 507 

5 404 468 459 

 

Ujilah apakah ada perbedaan antara lama kursus terhadap skore TOEFL? (Gunakan taraf 

signifikansi 5%). 

Analisis Perhitungan dengan SPSS. 



 

a. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

b. Isikan di kolom Name “LamaKursus” di baris pertama dengan decimals bernilai 0, dan 

“SkoreToefl” di baris ke dua dengan decimals bernilai 2.  

 
 

c. Pilih Data View dan masukan data lama kursus dan skore Toefl sebagai berikut.   

 
 

d. Pilih menu Analyze → Compare Mean → One Way Anova. 

 
 

e. Masukan variabel SkoreToefl ke kotak Dependent List, dan LamaKursus ke kotak 

Faktor. 



 

 
 

f. Klik tombol Post Hoc → LSD → Continue. 

 
 

g. Klik tombol Options → Descriptive → Homogeneity of Variances Test → Continue. 

 
 

h. Klik OK sehingga muncul hasil sebagai berikut. 

 



 

Output SPSS untuk Anova. 
Descriptives 

SkoreToefl   

 N Mean Std. Deviation Std. Error 

95% Confidence Interval for Mean 

Minimum Maximum Lower Bound Upper Bound 

3 5 417.2000 9.88433 4.42041 404.9270 429.4730 404.00 428.00 

6 5 449.2000 13.80942 6.17576 432.0533 466.3467 435.00 468.00 

9 5 483.6000 18.06378 8.07837 461.1709 506.0291 459.00 507.00 

Total 15 450.0000 31.03684 8.01368 432.8124 467.1876 404.00 507.00 

 

Test of Homogeneity of Variances 
SkoreToefl   

Levene Statistic df1 df2 Sig. 

.786 2 12 .478 

 

ANOVA 
SkoreToefl   

 Sum of Squares Df Mean Square F Sig. 

Between Groups 11027.200 2 5513.600 26.909 .000 

Within Groups 2458.800 12 204.900   

Total 13486.000 14    

 

Multiple Comparisons 
Dependent Variable:   SkoreToefl   

LSD   

(I) LamaKursus (J) LamaKursus 

Mean Difference 

(I-J) Std. Error Sig. 

95% Confidence Interval 

Lower Bound Upper Bound 

3 6 -32.00000* 9.05318 .004 -51.7252 -12.2748 

9 -66.40000* 9.05318 .000 -86.1252 -46.6748 

6 3 32.00000* 9.05318 .004 12.2748 51.7252 

9 -34.40000* 9.05318 .003 -54.1252 -14.6748 

9 3 66.40000* 9.05318 .000 46.6748 86.1252 

6 34.40000* 9.05318 .003 14.6748 54.1252 

*. The mean difference is significant at the 0.05 level. 



 

i. Pembacaan Hasil Analisis 

1) Tabel ANOVAmenunjukan hasil uji beda rata-rata secara keseluruhan. 

Hipotesis Penelitian : 

Ho : Ketiga kelompok memiliki rata-rata skore Toefl yang sama. 

H1 :Ketiga kelompokmemilikirata-rata skore Toeflyang berbeda. 

Ketentuan penerimaan/penolakan : 

Jika F hitung < F tabel, maka Ho diterima. 

Jika F hitung > F tabel, maka Ho ditolak. 

Atau  

Jika Sig > α, maka Ho diterima. 

Jika Sig < α, maka Ho ditolak. 

Hasil analisis ditemukan harga F hitung sebesar 26,909 dengan sig = 0,000. Oleh karena nilai 

sig < 0,05 maka Ho ditolak sehingga dapat disimpulkan ada perbedaan rata-rata skore 

Toefl antara mahasiswa yang mengambil kursus tiga bulan, enam bulan, dan Sembilan 

bulan.  

Keterangan: jika hasil pengujiannya signifikan maka dilanjutkan ke uji post hoc, tetapi jika 

tidak signifikan pengujian berhenti sampai di sini). 

2) Tabel Multiple Comparison smenunjukan hasil uji lanjut untuk mengetahui perbedaan 

antar kelompok secara spesifik sekaligus untuk mengetahui mana di antara ketiga 

kelompok tersebut yang skore Toeflnya paling tinggi. 

Hipotesis Penelitian: 

Ho : Kedua kelompok memiliki rata-rata skore Toefl yang sama. 

H1 : Kedua kelompok memiliki rata-rata skore Toefl yang tidak sama. 

Ketentuan penerimaan/penolakan: 

Jika Sig > α, maka Ho diterima. 

Jika Sig < α, maka Ho ditolak. 

Misalnya untuk melihat perbedaan skore Toefl antara mahasiswa yang kursus tiga bulan 

dan enam bulan diperoleh nilai sig = 0,004, Oleh karena nilai sig < 0,05 dapat 

disimpulkan bahwa ada perbedaan skore Toefl antara mahasiswa yang kursus tiga 

bulan dan enam bulan. Dalam hal ini skore Toefl mahasiswa yang kursus enam bulan 

lebih tinggi dari pada yang kursus tiga bulan. Dengan kata lain lama kursus 

berpengaruh terhadap peningkatan skore Toefl mahasiswa. 

 
 

 

  



 

Lampiran 4. Daftar Peserta 

 

Daftar Peserta 

 

Hari Tanggal : Sabtu, 9 September 2017 

Tempat : Lab. Komputer Jurdik.IPA UNY 

No Nama Lengkap Asal Instansi Partisipasi 

1. Ery Kusumawati, S.Pd SMP N 1 Minggir Peserta 

2. Lilik Nurkholidah, M.Pd SMP N 2 Purwosari Peserta 

3. Marfuah Azhar, S.Si SMP N 3 Godean Peserta 

4. Ari Hastarti, M.Pd SMP N 3 Godean Peserta 

5. Milatus Sa’diyyah, S.Pd SMP Tahfidzqu Peserta 

6. Titik Ratih D SMP N 2 Depok Peserta 

7. Erni Supatmiyati SMP N 1 Tempel Peserta 

8. Titik Dwi Endarto, S.Pd.Si SMP N 1 Srandakan Peserta 

9. Sekar Pendidikan IPA PPs UNY Asisten Praktikum 

10. Trian Anugrah Pendidikan IPA FMIPA UNY Asisten Praktikum 

11. Eko Widodo, M.Pd FMIPA UNY Pemateri 

12. Wita Setianingsih, M.Pd FMIPA UNY Pemateri 

13. Didik Setyawarno, M.Pd FMIPA UNY Pemateri 

 

 

 

 

 



 

Daftar Hadir Peserta PPM 

 
  



 

Lampiran 5.  Foto Kegiatan 

 

 
Gambar 1. Foto Pembukaan PPM 

 

 

 
Gambar 2. Penyampaian Materi PPM 

 



 

 
Gambar 3. Peserta Pelatihan PPM 

 

 
Gambar 4. Peserta Pelatihan PPM 



 

Lampiran 6. Respon Peserta

 
 



 

 
 

  



 

Lampiran 7. CV Tim PPM 
CURRICULUM VITAE KETUA 

 

A. IDENTITAS DIRI 

 

Nama Lengkap dan Gelar   : Drs. Eko Widodo, MPd 

Tempat dan Tanggal Lahir   : Banyumas, 12-12-1959 

NIP dan Karpeg    : 19591212 198702 1 001 dan E 204202 

Gol/Pangkat     : III d/ Penata Tk I 

Instansi     : FMIPA UNY 

Jabatan Fungsional    : Lektor 

Bidang Keahlian    : Pendidikan IPA 

Email      : ekowidodouny@gmail.com 
 

B. RIWAYAT PENDIDIKAN 

 

Jenjang Nama  

Pendidikan 

Jurusan, 

Universitas 

Tahun Lulus Tempat 

S1 IKIP Pend. Fisika 1986 Yogyakarta 

S2 UNY PTK 2010 Yogyakarta 

 

C. KEGIATAN DALAM SEMINAR 

ILMIAH/LOKAKARYA/PENATARAN/WORKSHOP/PAMERAN/PERAGAAN 

SELAMA  4 TAHUN TERAKHIR  
 

No Nama Kegiatan 
Waktu 

(tanggal/bulan/tahun) 
Tempat Penyaji Peserta 

1. Seminar Nasional 10 Mei 2014 FMIPA  Peserta 

 

D. PENELITIAN DALAM 4  TAHUN TERAKHIR  
 

No Judul Mandiri/Kelompok*) Tahun  Dana Jumlah 

1. 

Model Analisis Jalur 

Untuk Memetakan 

Academic Performance 

Assessment Mahasiswa 

Dalam Mata Kuliah 

Analytical Mechanics 

Melalui Suatu 

Pembelajaran Berbasis 

Pada Tes Konsep Di 

Kelas Internasional 

Eko Widodo,M.Pd, 

Suparno, Ph.D, Subroto, 

M.Pd, Bambang 

Ruwanto, M.Si 

2012 

DIPA 

BLU 

UNY 

R 

 

 

 

 

Rp.10.000.000,

- 

2. 

Model Revitalisasi 

Sekolah Terdampak 

Erupsi Melalui 

Pembuatan Perangkat 

Inovasi Berbahan Dasar 

Limbah Anorganik 

Eko Widodo,M.Pd,  

Asri Widowati, M.Pd., 

Suyoso, M.Si 

2014 

Jurnal 

Ilmiah 

Pendidik

an ( 

Cakrawal

a 

Pendidik

an ) 

 

3. 

Model Revitalisasi 

Sekolah Terdampak 

Erupsi Melalui 

Eko Widodo,M.Pd, Asri 

Widowati,M.Pd Al. 

Maryanto,M.Pd 

2014 
Hibah 

Bersaing 

Rp.50.000.000,

- 



 

Pemberdayaan 

Masyarakat Dalam  

Pembuatan Perangkat 

PembelajaranInovasi 

Berbahan Dasar Limbah 

Anorganik dan 

Implementasinya 

Sebagai Media Trauma 

Healing Dalam 

Pembelajara Sains 

 

E. PENGABDIAN PADA MASYARAKAT 
 

No Judul Mandiri/Kelompok*) Tahun 
Sumber 

Dana 
Jumlah 

1. 

 

 

 

 

 

 

 

 

 

 

2. 

 

 

 

 

 

 

 

 

 

3. 

Pelatihan 

Pembuatan Situs 

Pembelajaran 

Tak Berbayar 

Menggunakan 

Blogware 

Wordpress 

Dalam Rangka 

Meningkatkan 

Keterampilan 

Guru IPA 

Dalam 

Menyediakan 

Sumber Belajar 

On Line 

 

Pelatihan 

Pembuatan 

Tepung 

Belalang 

Sebagai Bahan 

Baku Makanan 

Dalam Upaya 

Optimalisasi 

Produk Pangan 

Lokal 

Berpotensi 

Tinggi Di 

Kabupaten 

Gunung Kidul 

 

Worshop  

Pembelajaran 

IPA Terpadu 

Prof. Dr. Zuhdan K.P, Sabar 

Nurohman,MPd 

Maryati, Msi, 

 

 

 

 

 

 

 

 

Maryati, MSi, 

Drs. Eko Widodo,MPd 

Ir. Ekosari R, MP. 

 

 

 

 

 

 

Maryati, MSi,MPd 

Drs. Eko Widodo,MPd 

Dr.Insih Wilujeng 

2009 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2009 

 

 

 

 

 

2011 

  

4. Pembinaan Pola 

Hidup Sehat 

Masyarakat 

Kecamatan 

Semanu 

Nur Rohmah Muktiani, 

M.Pd,Triatmanto,M.Si, Eko 

Widodo, M.Pd 

2012 DIPA 

UNY 

Rp.10.000.000,- 



 

Kabupaten 

Gunung Kidul 

5. Pembelajaran 

Petani Melalui 

Pelatihan Dan 

Pendampingan 

KKN Untuk 

Peningkatan 

Produktivitas 

Bawang 

Menggunakan 

Audio 

Bioharmonic 

System Sebagai 

Stimulator 

Pertumbuhan 

Alamiah 

Berbasis 

Frekuensi 

Binatang Lokal 

Eko Widodo, M.Pd, Nur 

Kadarisman, M.Si, Agus 

Purwanto, M.Sc. 

2013 Ditlitabm

as 

Rp.100.000.000,- 

7.  Pemberdayaan 

Masyarakat 

Terdampak 

Erupsi Merapi 

Melalui 

Pembuatan 

Perangkat 

Pembelajaran 

Inovasi 

Berbahan Dasar 

Limbah 

Anorganik dan 

Implementasiny

a Sebagai Media 

Trauma Healing 

Dalam 

Pembelajara 

Sains 

Suyoso, M.Si, Budi 

Purwanto. M.Si, Eko 

Widodo, M.Pd 

2014 Ditlitabm

as 

Rp. 65.000.000,- 

 

                                                                                             Yogyakarta, 27 Oktober 2017 

 

 



 

CURRICULUM VITAE ANGGOTA 1 

A. Identitas Diri 

1 Nama Lengkap (dengan gelar) Dr. Dadan Rosana, M.Si. 

2 Jenis Kelamin L/P 

3 Jabatan Fungsional Lektor Kepala 

4 NIP 196902021993031002 

5 NIDN 0002026904 

6 Tempat Tanggal Lahir Ciamis, 2 Februari 1969 

7 e-mail danrosana.uny@gmail.com 

8 No Telepon/HP 0274 4395516 /081392859303 

9 Alamat Kantor FMIPA UNY Karangmalang Yogyakarta 

10 No Telepon/Faks 02744565411/02744565411 

11 Lulusan Yang Telah Dihasilkan S1 =     45   orang 

S2 =      5       orang 

S3 =      0     orang 

12 Mata Kuliah yang Diampu Biophysics (International Class) 

Basic Physics (International Class) 

Item Response Theory 

Teori dan Teknik Pengukuran Pendidikan 

Evaluasi Pembelajaran Sains (S2) 

Applied Statistics (International Class) 

 

B. Riwayat Pendidikan 

 S1 S2 S3 

Nama 

Perguruan 

Tinggi 

IKIP Bandung ITB UNY 

Bidang Ilmu Pendidikan Fisika Fisika Penelitian dan Evaluasi 

Pendidikan 

Tahun Masuk-

Lulus 

1997-1992 1995-1997 2002-2008 

Judul Skripsi/ 

Tesis/Desertasi 

Perbedaan Hasil 

Belajar  Fisika 

antara Kelas 

Eksperimen dan 

Demnstrasi 

Analisis 

Numerik 

Reaktor 

PECVD 

Menggunakan 

Teori Finite 

Elemen 

Model Pembelajaran 

Lima Domain Sains  

dengan Pendekatan 

Kontekstual untuk 

Mengembangkan 

Pembelajaran Bermakna. 

Nama 

Pembimbing/Pr

omotor 

1. Drs. Didi 

Teguh Candra 

2. Drs. Omang 

Wirasasmita 

1. Toto 

Winata. 

Ph.D. 

1. Prof. Dr. Djemari 

Mardapi  

2. Prof. Dr. Sumadji 

3. Kamsul Abraha, 

Ph.D. 
 

 

  

mailto:danrosana.uny@gmail.com


 

 

C. Pengalaman Penelitan Dalam 5 Tahun Terakhir 

 

No 

 

Tahun 

 

Judul Penelitian 
Pendanaan 

Sumber Dana dalam  

juta (Rp) 

1 2015 Model Assessment Terstandar Berbasis 

Computer Management Instructional 

untuk Menjamin Kesetaraan Kualitas 

Penilaian Sebagai Basis Data Penentuan 

Kelulusan dalam Sistem Ujian Akhir 

Nasional dan SNMPTN Jalur Undangan 

yang Berkeadilan 

Hibah 

Kompetensi 

Ditlitabmas 

Dikti 

125 

2 2014 Pengembangan Integrated Science 

Instruction Assessment  Sebagai 

Alternatif Untuk Mengukur Pencapaian 

Kompetenai Inti Dan Kompetensi Dasar 

Dari Asp Dari Aspek Kognitif Dan 

Keterampilan Proses Sains Pada 

Kurikulum 2013 

Hibah Pasca 

Sarjana 

2014-2015 

Ditlitabmas 

Dikti 

100 

3 2011 5 strategies of entrepreuneurship 

learning (5 SoEL) untuk menghasilkan 

real entrepeuneur melalui pembentukan 

mind-set, attitude, skills, and  knowledge  

(MASK) (model pendidikan 

entrepreuneurship di Perguruan Tinggi) 

Penelitian 

Strategis 

Nasional  

DPPM Dikti 

85 

4 2009-

2010 

Pengembangan Model Implementasi 

ALFHE (Active Learning For Higher 

Education) dalam Kerangka Acuan  

Kerjasama  UNY, DBE2, dan USAID                      

Penelitian 

Unggulan 

PT DPPM 

Dikti 

80 

5 2012 Model Penelitian Kerjasama Institusi 

dalam Pemantauan Standar Nasional 

Pendidikan (SNP) Sebagai Basis Data 

untuk Pengembangan Grand Design 

Pendidikan di Wilayah Otonomi Menuju 

Tercapainya Millenium Development 

Goals (MDGs) 

Penelitian 

Unggulan 

PT DPPM 

Dikti 

50 

6 2011 Model KKN-PPL Tematik 

Pengembangan Kit Praktikum Sains 

Realistik Hasil Re-Use Limbah 

Anorganik Sebagai Media  Joyfull 

Learning   untuk Rehabilitasi 

Pendidikan dan Psikologis di Sekolah 

Terdampak Erupsi Merapi 

Hibah 

Bersaing 

DPPM Dikti 

45 

7 2008 Model Kesiapsiagaan Bencana (Disaster 

Preparedness) Dalam Bentuk 

Pembelajaran Sekolah Darurat 

Dengan Pendekatan Fun Learning 

Menggunakan Media Pembelajaran 

Dari Limbah Rumah Tangga Untuk 

Penanganan Pendidikan di Daerah 

Pasca Bencana  

Hibah 

Bersaing 

DPPM Dikti 

45 



 

8 2011 Model Bimbingan Teknis Ujian Nasional 

Sekolah Berbasis Pesantren 

Berdasarkan Analisis Daya Serap dan 

Analisis Butir Soal Untuk 

Pemerataan Akses Pendidikan 

DIPA _UNY 10 

 

D. Pengalaman Pengabdian Masyarakat Dalam 5 Tahun Terakhir  

 

No 

 

Tahun 

 

Judul Pengabdian Pada Masyarakat 
Pendanaan 

Sumber Dana dalam  

juta (Rp) 

1 2015 Pemberdayaan Pemuda Usia Produktif 

Melalui Kelembagaan Karang Taruna 

Dalam Bentuk Pelatihan dan 

Pendampingan KKN PPM Produksi 

Kerajinan Mozaik Kaca Sebagai 

Komoditi Ekspor Potensial dan Souvenir 

Kota Wisata Yogyakarta 

KKN PPM 

Ditlitabmas 

Dikti 

85 

2 2013 Pemberdayaan Masyarakat Pemulung 

dalam Produksi Kit Praktikum Sains 

Realistik Hasil Re-Use Limbah 

Anorganik Sebagai Media  Joyfull 

Learning  Untuk Implementasi 

Kurikulum 2013 Aspek Penelitian Ilmiah 

 

KKN PPM 

Ditlitabmas 

Dikti 

75 

3 2015 Pemanfaatan Pembuatan Laboratorium 

Alam dan Pemanfaatan Bahan di 

Lingkungan Sekitar untuk Pembelajaran 

IPA yang Aktif, Kreatif dan 

Menyenangkan   

DIPA 

FMIPA 

UNY 

20 

4 2012 Pelatihan Perancangan dan Penggunaan 

Kit Praktikum Fisika Berbasis Teknologi 

Multi Function Equipment Untuk 

Ekperimen Fisika Penyandang Tuna 

Netra Dan Tuna Rungu (Berbasis 

Penelitian Hibah Bersaing 2010) 

DIPA UNY 10 

5 2012 Pelatihan Perancangan dan Penggunaan 

Audio Organic Growth System (AOGS) 

Berbasis Frekuensi Binatang Alamiah 

untuk Peningkatan Produktivitas Petani 

Kacang panjang dan Bawang Merah 

(Berbasis Penelitian Strategis Nasional 

2010) 

DIPA UNY 10 

 
  



 

E. Publikasi Artikel Ilmiah dalam Jurnal dalam 5 Tahun Terakhir 

 
No Judul Artikel Ilmiah Nama Jurnal Volume/Nomor/Tahun 

1 Analisis Butir dan Identifikasi 

Ketidakwajaran 

Skor Ujian Akhir Sekolah untuk 

Standarisasi Penilaian 

Jurnal 

Kependidikan  

Terakreditasi 

Nasional 

Volume 45, Nomor 2, 

November 2015, 

Halaman 130-141 

2 Laboratory Practice Model Training 

of Heat and Temperature by Voice 

Thermometer equipment for 

Unvisible and Unauditory Students 

INOTEK Journal Edisi  17, No. 2, 

Agustus 2013 

3 Five Strategies of Entrepreneurship 

learning untuk Mengahsilkan Reall 

Entrepreneur Model Pendidikan 

Entrepreneurship 

Cakrawala 

Pendidikan 

Terakreditasi 

Nasional 

XXXI,No.1, ,  Februari 

2012Th 

 

4 Pengembangan Soft Skills 

Mahasiswa Program Kelas 

Internasional Melalui Pembelajaran 

Berbasis Konteks Untuk 

Meningkatkan Kualitas Proses dan 

Hasil Belajar Mekanika 

Jurnal Pendidikan 

IPA Indonesia 

(Indonesian 

Journal of Science 

Education). JPII 

Terideks DOAJ 

Volume 3, No. 1, April 

2015 

5 Pengembangan Alat Praktikum Sains 

(Fisika) untuk Anak Penyandang 

Ketunaan serta Aplikasinya pada 

Pendidikan Inklusif 

Jurnal Materi dan 

Pembelajaran 

Fisika (JMPF) 

Prodi Pendidikan 

Fisika PMIPA 

FKIP UNS 

Volume 4 Nomor 2 

2014. 

6 Peranan Research and Development 

(R&D) dan Structural Equation 

Modelling (SEM) dalam Penelitian 

Pengembangan Kurikulum Tingkat 

Satuan Pendidikan  

Cakrawala 

Pendidikan 

Terakreditasi 

Nasional 

Juni 2008, Th XXVII, 

No.2 

7 Pengembangan Budaya Kualitas 

melalui Penerapan ISO 

9001:2000 di Universitas Negeri 

Yogyakarta 

Jurnal Cakrawala 

Pendidikan  
Vol.III. Nomor 1 

tahun 2009 

8 Model Akselerasi Pengembangan 

Sambi Sebagai Desa Wisata 

International Melalui Strategi 

Kemitraan dan Pemberdayaan 

Masyarakat Dalam Penerapan 

Literasi Sains dan Teknologi 

dengan Dukungan Kompetensi 

Komunikasi Bahasa Global 

Jurnal Penelitian 

Humaniora  

Lembaga 

Penelitian UNY 

Vol.I. Nomor 2 tahun 

2009 

9 Model Pembelajaran Lima Domain 

Sains  dengan Pendekatan 

Kontekstual untuk Mengembangkan 

Pembelajaran Bermakna. 

Jurnal Penelitian 

dan Evaluasi 

Pendidikan 

Tahun 13, Nomor 2, 

Tahun 2009 

 

 

 

 

 



 

F. Pemakalah Seminar Ilmiah (Oral Presentation) Dalam 5 Tahun Terakhir 

 

No Nama pertemuan 

ilmiah/seminar 

Judul artikel Ilmiah Waktu dan Tempat 

1 
3rdInternational Conference 

On Educational Research and 

Innovation (ICERI) 2015 

 

Integrated Assessment 

Information System To 

Support The Application 

Of Scientific Approach In 

The High School Level 

UNY 

6-7 Mei 2015. 

2 

3rdInternational Conference 

On Educational Research and 

Innovation (ICERI) 

Integrated Development 

Assessment Of Science 

Instruction As An 

Alternative To Measure 

The Achievement Of Core 

Competence And 

Competence Basic Aspects 

Of Cognitive Processes 

And Skills 

UNY 

6-7 Mei 2015. 

3 

The 2nd  

International Conference on 

Research, 

Implementation and Education 

of mathematics and Science 

(2nd ICRIEMS) 

Use of Computer 

Managemant Instruction 

For Development 

Standardized Test for 

Equivalency Quality 

Assessment as 

Determinants of School 

Graduation in The National 

Exam System Fair 

LPPM UNY 

17 – 19 May 2015, 

4 

Seminar Nasional Fisika dan 

Pendidikan Fisika 

Pengembangan Alat 

Praktikum Sains (Fisika) 

Untuk Anak Penyandang 

Ketunaan Serta 

Aplikasinya Pada  

Pendidikan Inklusif 

UNS Surakarta 

13 September 2014 

5 

Seminar Nasional Pendidikan 

IPA  

 

Telaah Kritis Tentang  

Landasan Filosofis 

Kurikulum 2013 Dan 

Implementasinya 

Menggunakan Pendekatan 

Saintifik 

Universitas 

Sarjanawiyata 

Tamansiswa, 

22 November 2014 

6 

Seminar Nasional ALFA III 

(Active Learning Facilitator 

Ascociation) DBE2  USAID 

Penerapan Pembelajaran 

Aktif Dalam 

Mengoptimalkan Kualitas 

Hasil Belajar Dengan 

Pendekatan Saintifik 

 

UNNES  Semarang 

6 desember 2014 

7 

Seminar Nasional ALFA IV 

(Active Learning Facilitator 

Ascociation) DBE2  USAID 

Urgensi Authentic 

Assessment Dalam 

Implementasi Pembelajaran 

Aktif Untuk Penilaian 

Proses dan Hasil Belajar 

Secara Terintegrasi 

FMIPA UNY 

9 Mei 2015 

8 Seminar Nasional IPA V 

 

Pendekatan Saintifik 

Dalam Pembelajaran IPA 

FMIPA UNNES 

Semarang 



 

Secara Terpadu 7 Mei 2014 

9 
Seminar Penjaminan Mutu 

Perguruan Tinggi 

Sekolah Tinggi Multimedia 

(STMM “MMTC)  

Manajemen Pengelolaan 

Program Studi 

Sekolah Tinggi 

Multimedia (STMM 

“MMTC) 

Yogyakarta, 20 

November 2014 

10  Seminar Nasional Pendidikan 

IPA ke IV, Unesa 2012 

Menggagas Pendidikan 

IPA Yang Baik Terkait 

Esensial 21st Century Skills 

Desember 2012 FMIPA 

UNESA Surabaya 

11 International Seminar Go 

Green 

Science Equipment 

Improving From 

Household Waste Recycle 

By Partnership Strategy 

Between Scavengers And 

School Society 

Agustus 2011, Universitas 

Islam Indonesia  

12 Seminar Nasional MIPA  Pengembangan Soft Skills 

Mahasiswa Program Kelas 

Internasional Melalui 

Pembelajaran Berbasis 

Konteks Untuk 

Meningkatkan Kualitas 

Proses Dan Hasil Belajar 

Fisika Dasar 

 

Mei 2011, FMIPA UNY 

13 International Seminar Aplication Of Structural 

Equation Modeling For  

The Influence Analysis 

Of  Psycho-Social 

Environments Of 

Science and Teacher 

Competence To Develop 

Five Domains Of 

Science  

 

Oktober 2010, 

PPS UPI Bandung 

14 The First International 

Conference on Sustainable 

Built Environment 

Disaster Preparedness in 

the Form of Model 

Emergency School 

Learning with Fun 

Learning Approach 

Using Recycling 

Household Waste 

Learning Media 

Jogjakarta, Indonesia, 

May 27-29, 2010 

 

G. Karya Buku Dalam 5 Tahun Terakhir 

No Judul Buku Tahun Jumlah Halaman Penerbit 

1 Evaluasi 

Pembelajaran Sains 

2015 663 UNY Press ISBN 

978-602-7981-69-0 

1 Biofisika 2008 255 Universitas Terbuka 

2 Evaluasi 

Pembelajaran Fisika 

2013 268 Universitas Terbuka 

 

 



 

I. Pengalaman Merumuskan Kebijakan Publik/Rekayasa Sosial Lainnya dalam 5 

Tahun Terakhir 

 

No Judul/Tema/Jenis Rekayasa 

Sosial lainnya yang telah 

diterapka 

Tahun Tempat 

Penerapan 

Respon 

Masyarakat 

1 Penyusun Buku Pedoman 

Pengelolaan Laboratorium 

Direktorat PSMP 

2014 Seluruh 

Indonesia 

Baik 

2 Tim Narasumber Pelatihan 

Laboratorium IPA Direktorat 

PSMP 

2014 Seluruh 

Indonesia 

Baik 

3 Perumusan Laporan dan 

Pelaksanaan Pemantauan 

Standar Nasional Pendidikan 

(BSNP) 

2011 Seluruh 

Indonesia 

Baik 

4 Tim Perumus Naskah 

Akademik Penguatan 

Kurikulum dengan Nilai 

Karakter, Kewirausahaan dan 

Pengurangan Resiko Bencana 

2010 Pusat 

Kurikulum 

(Nasional) 

Baik 

5 Perumusan Laporan dan 

Pelaksanaan Pemantauan 

Implementasi Standar 

Pendidikan  

2012 Kabupaten 

Bulungan 

Baik 

 

J. Penghargaan dalam 10 tahun terakhir (dari pemerintah, asosiasi atau institusi lainnya) 

No Jenis Penghargaan Institusi Pemberi 

Penghargaan 

Tahun 

1 Satya Lencana  Prasetya 10 tahun 

pengabdian 

Lembaga 

Kepresidenan 

2005 

2 Penyaji presentasi Terbaik seminar 

Penelitian Strategis Nasional  

DPPM (Ditlitabmas) 

Dikti 

2010 

3 Penyaji Poster Terbaik seminar 

Penelitian Strategis Nasional  

DPPM (Ditlitabmas) 

Dikti 

2010 

 

Semua data yang saya isikan dan tercantum dalam biodata ini adalah benar dan dapat 

dipertanggungjawabkan secara hokum. Apabila dikemudian hari dijumpai ketidak sesuaian 

dengan kenyataan, saya sanggup menerima sangsi. 

 

Yogyakarta, 15 Februari 2017 

             Pengusul 

 
    Dr. Dadan Rosana, M.Si. 

                                                                                                      NIP. 196902021993031002 

 

 

 

 



 

CURRICULUM VITAE ANGGOTA 2 

 

1. Nama Lengkap : Didik Setyawarno, S.Pd.Si., M.Pd. 

2. NIP : 19881013 201504 1004 

3. Tempat dan Tanggal 

Lahir 

: Blora, 13 Oktober 1988 

4. Pekerjaan : Dosen Pendidikan IPA FMIPA UNY 

5. NIDN/ Jabatan 

Akademik 

: 0013108801/ Tenaga Pengajar 

6. Jabatan Akademik : Tenaga Pengajar 

7. Email : didikssetyawarno@yahoo.co.id  

didiksetyawarno@uny.ac.id  

8. Bidang Keahlian : Evaluasi Pemebelajaran IPA 

9. No HP : 085 727 356 876 

10. Riwayat Pendidikan :  

 a. SD Gabusan IV (1995-2001) 

b. SMP N 1 Doplang (2001-2004) 

c. SMA N 1 Randublatung (2004-2007) 

d. S1 Pendidikan Fisika UNY (2007-2010) 

e. S2 Pendidikan Sains (Konsentrasi Fisika, 2011-2013) 
  

11. Pengalaman Bidang Akademik : 

 a. Dosen PGSD UM Palangkaraya (Semeseter genap 2013/2014) 

b. Staf LP3MPT UM Palangkaraya (Bidang Perencanaan dan Penjaminan Mutu, 

2014) 

c. Anggota tim akreditasi institusi UM Palangkaraya dalam rangka menyusun boring 

akreditasi dan evaluasi diri (2014). 

d. Anggota tim akreditasi Program Studi S1 Syariah UM Palangkaraya (2014) 

e. Juri olimoiade fisika SMA dalam rangka Pekan Ilmiah Fisika UNY (2014) 

f. Juri lomba TPA Masjid Asysyifa bidang tartil Qur’an (2014) 

g. Penyusun soal olimpiade fisika dan juri olimpiade fisika Himafi UNY dalam 

rangka dies natalis UNY ke-48 (2013) 

h. Juri olimpiade fisika Himafi UNY dalam rangka Pekan Ilmiah Fisika (2013) 

i. Juri lomba karya tulis Qur’ani Haska FMIPA UNY (2013) 

j. Juri festival anak sholeh Haska FMIPA UNY bidang tartil (2013) 

k. Mengampu mata kuliah : 

1) IPA II 

2) Praktikum IPA II 

3) Praktikum Fisika Dasar II 

4) Statistik Terapan 

l. Anggota Tim Olimpiade Sains Nasional (Pusat Studi Kebumian, Geografi, Fisika, 

dan Astronomi, 2011-2012 dengan Ketua Tim Zainal Imron Hidayat peraih medali 

perak tingkat internasional) 

m. Pembina Olimpiade Fisika SMA Tk Provinsi di SMA N 1 Kudus (Tahun 2012) 

 
12. Trainning/ Pelatihan : 

 a. Audit Mutu Akademik Internal (AMAI) di UMY (28 Februari-1 Maret 2014) 

b. Penyusunan borang akreditasi di UIN Syarif Hidayatulloh (3-4 Maret 2014) 

c. Penyusunan artikel ilmiah di UM Palangkaraya. 

d. Multimedia di Fasnet UGM (28 September- 28 November 2014) 

 

 

mailto:didikssetyawarno@yahoo.co.id
mailto:didiksetyawarno@uny.ac.id


 

14. Pengalaman Penelitian 5 Tahun Terakhir :  
 a. Penelitian Tracer Study Alumni UM Palangkaraya Periode Lulusan 2012 (Hibah 

Dikti dengan dana 38 Juta Tahun 2014) 

b. Pengembangan Pengembangan Indonesian Qualification Framework (IQF) Level 

6 Program Studi Pendidikan Biologi, Pendidikan Fisika, dan Pendidikan Kimia 

Perguruan Tinggi (Hibah Pascasarjana DIPA UNY sebagai salah satu anggota 

peneliti untuk tahun pertama dengan Ketua Peneliti Prof. Dr. Zuhdan Kun Prasetyo 

dengan dana Rp. 100 Juta Tahun 2013) 

c. Relevansi Kurikulum dan Proses Pembelajaran Program Studi S1 Pendidikan 

Fisika Universitas Negeri Yogyakarta terhadap KKNI Level 6 Pendidikan Fisika 

(Tesis Tahun 2013) 

d. Tracer Study Lulusan Universitas Negeri Yogyakarta Tahun 2010 (Hibah Tracer 

Study Dirjen Dikti sebagai salah satu anggota dengan Ketua Peneliti Minta 

Suharsana, M.Sc dengan dana Rp. 25 Juta Tahun 2012) 

e. Pengaruh Pendekatan Inquiry pada Pembelajaran Fisika terhadap Hasil Belajar dan 

Keterampilan Mengukur Objek Fisika pada Siswa MAN Yogyakarta I (Skripsi 

Tahun 2010) 

f. Pengaruh Medan Magnetik Eksternal pada Tabung Gas Hidrogen terhadap 

Spektrum Emisi pada Efek Zeeman (Kolokium Tahun 2010) 

g. Pengaruh Intensitas Cahaya dan Spektrum Cahaya Tampak Terhadap Pertumbuhan 

Udang Putih (Litopenaeus vannamei) Ditinjau dari Segi Hubungan Panjang dan 

Berat (Hibah PKMP Dirjen Dikti sebagai salah satu anggota dengan Ketua Peneliti 

Drs. Al Maryanto dengan dana Rp. 7 Juta Tahun 2009) 

h. Akselerasi Pertumbuhan Ikan Mujair Menggunakan Variasi Intensitas dan 

Spektrum Cahaya Tampak (Hibah PKMP Dirjen Dikti sebagai salah satu anggota 

dengan Ketua Peneliti Drs. Al Maryanto dengan dana Rp. 6 Juta Tahun 2008 
13. Pengalaman Penyampaian Makalah Secara Oral pada Seminar Nasional :  
 a. Relevansi Kurikulum S1 Pendidikan Fisika Universitas Negeri Yogyakarta 

terhadap KKNI Level 6 Pendidikan Fisika (Seminar Nasional S1 Pendidikan Fisika 

FMIPA UNY Tahun 2013) 

b. Model Pembelajaran Berprograma untuk Optimalisasi Pembelajaran Sains Jarak 

Jauh (Seminar Nasional S2 Pendidikan Sains Program Pascasarjana UNY Tahun 

2012)  
14. Pengalaman Penulisan Jurnal : 
 a. Pengembangan Kerangka Kualifikasi Nasional Indonesia (KKNI) Level 6 

Pendidikan Fisika 

b. Pengaruh Medan Magnetik Eksternal pada Tabung Gas Hidrogen terhadap 

Spektrum Emisi pada Efek Zeeman (Jurnal Anterior UM Palangkaraya) 

c. Relevansi Kurikulum S1 Pendidikan Fisika Universitas Negeri Yogyakarta 

terhadap KKNI Level 6 Pendidikan Fisika (Prosiding Seminar Nasional Fisika dan 

Pendidikan Fisika Tahun 2013, ISBN : 978-602-99834-5-6)  

d. Model Pembelajaran Berprograma untuk Optimalisasi Pembelajaran Sains Jarak 

Jauh (Volume 1, Nomor 1, Tahun 2012, S2 Pendidikan Sains UNY)  
Demikian curriculum vitae saya buat dengan sebenarnya semoga dapat digunakan sebagai salah satu 

bahan pertimbangan. 

Yogyakarta, 4 Maret 2017 

 

 

 

Didik Setyawarno, M.Pd. 

 



 

 


